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Preface
The Quartus® II Installation & Licensing for Windows manual provides the 
information you need to install the Altera Complete Design Suite software 
and to start the Quartus II design software.

This manual is intended for all Quartus II software users, from beginning to 
advanced.

This manual provides comprehensive information for installing and 
licensing the Altera Complete Design Suite software, and includes 
information about the following topics:

■ How to install the Altera Complete Design Suite software

■ How to license the Altera Complete Design Suite software

■ Other documentation and technical support information
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Documentation Conventions
The Quartus® II Installation & Licensing for Windows manual uses the following 
conventions to make it easy for you to find and interpret information.

Typographic Conventions

Quartus II documentation uses the typographic conventions shown in the 
following table:

Visual Cue Meaning

Bold Initial 
Capitals

Command names; dialog box, page, and tab titles; and button names 
are shown in bold, with initial capital letters. For example: Find Text 
command, Save As dialog box, and Start button.

bold Directory names, project names, disk drive names, file names, file 
name extensions, software utility names, software executable 
names, and options in dialog boxes are shown in bold. Examples: 
quartus directory, d: drive, and license.dat file.

Initial Capitals Keyboard keys, user-editable application window fields, and menu 
names are shown with initial capital letters. For example: Delete key 
and the Options menu.

“Subheading 
Title”

Subheadings within a manual section are enclosed in quotation 
marks. In manuals, titles of Help topics are also shown in quotation 
marks.

Italic Initial 
Capitals

Help categories, manual titles, section titles in manuals, and 
application note and brief names are shown in italics with initial 
capital letters. For example: FLEXlm End Users Guide.

italics Variables are enclosed in angle brackets (< >) and shown in italics. 
For example: <file name> and <CD-ROM drive>.

Courier font Anything that must be typed exactly as it appears is shown in 
Courier. For example: \quartus\bin\lmutil lmhostid.

r Enter or return key.

■ Bullets are used in a list of items when the sequence of the items is 
not important.

v The checkmark indicates a procedure that consists of one step only.

! The hand points to information that requires special attention.
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Terminology

The following table shows terminology that is used throughout the 
Quartus II Installation & Licensing for Windows manual:

f The feet show you where to go for more information on a particular 
topic.

w The exclamation mark points to information or action that you take 
that can cause harm to your computer or cause you to lose data.

Visual Cue Meaning

Term Meaning

“click” Indicates a quick press and release of the left mouse button. It 
also indicates that you need to use a mouse or key combination 
to start an action.

“double-click” Indicates two clicks in rapid succession.

“select” Indicates that you need to highlight text and/or objects or an 
option in a dialog box with a key combination or the mouse. A 
selection does not start an action. For example: Select Chain 
Description File, and then click OK.

“point” Indicates that you need to position the mouse pointer, without 
clicking, at an appropriate location on the screen, such as a 
menu or submenu. For example: On the Help menu, point to 
Altera on the Web, and then click Quartus II Service 
Request.

“turn on”/“turn off” Indicates that you must click a check box to turn a function on 
or off.
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Introduction
This chapter describes the requirements and procedures for installing the 
Altera Complete Design Suite for Windows, which is available on a single 
DVD-ROM, or the following Altera software CD-ROMs (some listed 
CD-ROMs may not be included in your current Altera® Package):

■ Quartus® II Design Software for Windows Version 6.1
■ ModelSim-Altera VHDL & Verilog HDL Simulation Tool Version 6.1g
■ MegaCore® IP Library Version 6.1
■ Nios® II Embedded Design Suite Version 6.1 for Windows

The Altera Complete Design Suite for Windows Version 6.1 DVD-ROM 
includes all of the above software and additionally includes the Quartus II 
Web Edition Software Version 6.1 for Windows and ModelSim-Altera Web 
Edition Software Version 6.1g for Windows.

Altera Complete Design Suite 
System Requirements

Your system must meet the following minimum requirements:

■ Intel Pentium III PC running at 866MHz or faster with 256-MB system 
memory (faster systems give better software performance)

■ Disk space requirements, as described in the readme.txt file, which is 
located in the top-level directory of the Altera Complete Design Suite 
DVD-ROM or the Quartus II software CD-ROM. After installation, the 
readme.txt file is available from the Quartus II Help menu and in the 
Quartus II system directory.

■ Microsoft Windows 2000, Windows XP, or Windows XP Professional 
x64 Edition. 

PCs running Windows 2000 or Windows XP are capable of running the 
32-bit version of the Quartus II software with access to virtual memory 
of up to 2-GB. PCs running Windows XP Professional x64 Edition are 
capable of running the 32-bit version of the Quartus II software with 
access to virtual memory of up to 4-GB and the 64-bit version of the 
Quartus II software with access to virtual memory of more than 4-GB. 
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■ Microsoft Windows–compatible SVGA monitor

■ CD-ROM drive (CD-ROM installation)

■ DVD-ROM drive (DVD-ROM installation)

■ Hummingbird Exceed XServer software is required if you want to 
access the Quartus II software from a Windows PC to a Linux or UNIX 
server.

■ A web browser with an Internet connection, which is required to enable 
the Quartus II software Internet connectivity features. If you are using 
the Netscape Navigator or Microsoft Internet Explorer browser, 
version 5.0 or later is required. 

■ One or more of the following ports:
– Parallel port for use with the ByteBlaster™ II or ByteBlasterMV™ 

parallel port download cable or Parallel Port Software Guard 
(Windows 2000 or Windows XP only)

– Serial port for use with the MasterBlaster™ communications cable
– USB port for use with the USB-Blaster™ download cable, the 

MasterBlaster communications cable, the Altera Programming 
Unit (APU), or the USB Software Guard (Windows 2000, Windows 
XP, or Windows XP Professional x64 Edition only)

– 10/100 Mb Ethernet connection for use with the EthernetBlaster 
download cable
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Uninstalling or Modifying 
Previously Installed Versions of 
Altera Software

If you have installed a previous version of the Quartus®, Quartus II, or 
related software, you can uninstall that software, if you wish, before 
installing the current version of the Quartus II software or related software. 
You can also modify versions of the Quartus II software or related software 
after installation.

f For Information About Refer To

Specific disk space and memory 
requirements

The readme.txt file, which is located in the 
top-level directory of the Altera Complete 
Design Suite software DVD-ROM and the 
Quartus II software CD-ROM. After 
installation, the readme.txt file is available 
from the Quartus II Help menu and in the 
Quartus II system directory.

Updated information about system 
requirements and the most current 
version of the Quartus II Installation & 
Licensing for Windows manual

Quartus II Installation & Licensing for 
Windows manual on the Altera website.

Latest information on new features, 
device support, EDA interface support, 
and known issues and workarounds 
for the Quartus II software

Quartus II Software Release Notes 
document on the Altera website.

Quartus II software features and how 
they work with your design flow

Introduction to Quartus II manual on the 
Altera website and the Quartus II 
Interactive Tutorial. After installation, the 
Quartus II Interactive Tutorial is available 
from the Quartus II Help menu and in the 
Quartus II system directory

Altera programming hardware Altera Programming Unit User Guide, 
ByteBlaster II Download Cable User Guide, 
ByteBlasterMV Download Cable User Guide, 
EthernetBlaster Download Cable User 
Guide, MasterBlaster Serial/USB 
Communications Cable User Guide, and 
USB-Blaster Download Cable User Guide on 
the Altera website.
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Uninstalling Previously Installed 
Versions of Altera Software

To uninstall a previous version of the Quartus or Quartus II software, or 
related software, versions 6.0 or earlier:

v On the Windows Start menu, point to All Programs, click Altera, and 
then click <software> <version number> Uninstall, Repair or Modify.

To uninstall a previous version of the Quartus II software, or related 
software, versions 6.1 or later:

1. On the Windows Start menu, point to All Programs, point to Altera, 
point to <software> <version number>, and then click <software> 
<version number> Uninstall, Repair or Modify. The Quartus 6.1 Setup 
Maintenance program opens.

2. Select Remove to remove all installed features.

3. Click Next.

To uninstall a previous version of the Quartus II software, or related 
software, that was installed with the Altera Complete Design Suite:

v On the Windows Start menu, point to All Programs, point to Altera, 
and then click Uninstall Altera Design Suite<version number>.

Modifying Versions of the Quartus II 
Software or Related Software

You can modify currently installed versions of the Quartus II software, or 
related software, to add or remove software components such as specific 
device family support, MegaCore IP functions, or tutorial files.

To modify an installed version of the Quartus II software, or related 
software, version 6.1 or later:

1. On the Windows Start menu, point to All Programs, point to Altera, 
point to <software> <version number>, and then click <software> 
<version number> Uninstall, Repair or Modify. The Quartus 6.1 Setup 
Maintenance program opens.
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2. Select Modify to select new program features to add, or to select 
currently installed features to remove.

3. Click Next.

4. Select the features you want to install or deselect the features you want 
to uninstall.

5. Click Next.

Altera Complete Design Suite
The Altera Complete Design Suite for Windows version 6.1 is an integrated 
software installation solution that allows you to install the Quartus II 
software and related software, which are listed in “Introduction” on page 2, 
from one DVD-ROM.

The Altera Complete Design Suite for Windows uses a Setup program that 
automatically launches once you start the installation process. The Setup 
program allows you to select the software you want to install and 
automatically guides you through the installation process.

You can choose to perform a recommended or custom installation. A 
recommended installation automatically installs the software that you 
specified in the beginning of the Setup program using all program features 
and default settings. A custom installation allows you to customize options 
for each software installation.

Choosing a custom installation also allows you to select either a complete or 
custom installation for each software.

You can also access educational and reference materials, such as software 
video demos and reference designs from the Altera Complete Design Suite 
for Windows.

The Altera Complete Design Suite for Windows installation flow is shown 
in Figure 1.
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Figure 1. Altera Complete Design Suite Installation Flow
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Quartus II Software

The Quartus II software is the first software installed during the Altera 
Complete Design Suite for Windows, Version 6.1 recommended (complete) 
installation. You can choose to perform a complete installation, which 
installs the Quartus II software with all program features and default 
settings, or a custom installation, which allows you to select specific 
program features.

If you select a custom installation, you can select any of the following 
software components to customize your Quartus II software installation:

■ Quartus II software
■ Quartus II software 64-bit components (Quartus II software 

Subscription Edition only)
■ Device support
■ Third-party EDA tool interfaces
■ Quartus II Interactive Tutorial files

You can select specific device families for device support in the Quartus II 
software.

You must select Quartus II software 64-bit components during installation 
if you want to run the 64-bit version of the Quartus II software.

MegaCore IP Library

The MegaCore IP Library is the second software installed during the Altera 
Complete Design Suite for Windows version 6.1 recommended (complete) 
installation. You can choose to perform a complete installation, which 
installs the MegaCore IP Library with all program features and default 
settings, or a custom installation, which allows you to select specific 
program features.

If you select a custom installation, you can select any of the following IP 
components to customize your MegaCore IP Library installation:

■ Communications
■ DSP
■ Interfaces
■ Nios II IP
■ SOPC Builder IP
■ Embedded Peripherals
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You can select specific MegaCore functions to install with the MegaCore IP 
Library. Because the Altera Complete Design Suite does not check for 
dependencies between MegaCore functions, you must ensure that you 
install all dependent MegaCore functions with the MegaCore functions that 
you select.

You also can add or remove any individual MegaCore function after you 
have completed the MegaCore IP Library installation. To add or remove an 
individual MegaCore function, perform the procedure in “Uninstalling or 
Modifying Previously Installed Versions of Altera Software” on page 4.

Nios II Embedded Design Suite

The Nios II Embedded Design Suite is the third software installed during the 
Altera Complete Design Suite for Windows version 6.1 recommended 
(complete) installation. You can choose to perform a complete installation, 
which installs the Nios II Embedded Design Suite with all program features 
and default settings, or a custom installation, which allows you to select 
specific program features.

If you select a custom installation, you can select any of the following 
components to customize your Nios II Embedded Design Suite installation:

■ Nios II Software Development Tools
■ Verilog examples
■ VHDL examples
■ Tutorials

ModelSim-Altera Software

The ModelSim-Altera software is the fourth software installed during the 
Altera Complete Design Suite for Windows version 6.1 recommended 
(complete) installation.
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Installing the Altera Complete 
Design Suite DVD-ROM

You should be aware of the following information before you install the 
Altera Complete Design Suite for Windows, Version 6.1 DVD-ROM:

■ You must have system administration (Administrator) privileges.

■ You must have the Altera Complete Design Suite for Windows, Version 
6.1 DVD-ROM to perform the installation.

■ By default, the Setup program installs the Altera Complete Design 
Suite for Windows, Version 6.1 software in the <drive>:\altera\
<version number> system directory, where <version number> is the 
number of the Quartus II software version; for example, the default 
directory for the Quartus II software version 6.1 is <drive>:\altera\61.

■ You can install multiple copies of the same version of the Altera 
Complete Design Suite for Windows, Version 6.1 on the same PC. 
Subsequent installations of the software can have a user-defined name. 
By default, the Setup program uses the format “Quartus II <version 
number> (Copy <number>)” for multiple copies of the Quartus II 
software, where Copy <number> is the number of Quartus II software 
installations that are installed on the PC; for example, the default name 
for a second copy of the Quartus II software version 6.1 is Quartus II 
6.1 (Copy 2). When installing a Quartus II service pack on a PC that has 
multiple copies of the same version of the Quartus II software installed, 
the installation program allows you to choose the copy of the Quartus 
II software that receives the service pack.

■ If you want to preserve project compilation databases from an earlier 
version of the Quartus II software before installing a newer version, 
Altera recommends that you open the design in the earlier version of 
the software and export a version-compatible database for the design 
by clicking Export Database on the Project menu. After you have 
installed a newer version of the Quartus II software, you can import the 
database in the new version by clicking Import Database on the Project 
menu. For more information about importing and exporting version-
compatible databases, see “Exporting and Importing Version-
Compatible Database Files” in Quartus II Help. Version-compatible 
database files are available in Quartus II software version 4.1 and later.
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Follow these steps to run the Setup program on your PC:

1. Insert the Quartus II Complete Design Suite for Windows, Version 6.1 
DVD-ROM into your DVD-ROM drive. The Quartus II Install 
DVD-ROM window appears automatically, offering several options. If 
the DVD-ROM is in the drive, and the Setup program is not already 
running, start the Setup program manually by performing the 
following steps:

a. On the Windows Start menu, click Run.

b. In the Run dialog box, type <DVD-ROM drive>:\install.

c. Click OK.

2. Click Install subscription package or Install free package to install the 
Quartus II software and related software. Installing the subscription 
package requires a paid subscription license, and installing a free 
package requires a free license.

You can click Help me choose to access the Quartus II Software: 
Subscription & Web Edition Comparison page of the Altera website 
(www.altera.com), which compares the features of the Quartus II 
Subscription software with the Quartus II Web Edition software.

3. If you want to install the Stand-Alone Programmer and the Stand-
Alone SignalTap® II Logic Analyzer, click Install Quartus II software 
v6.1 Stand-Alone Programmer. The Setup program starts 
automatically and guides you through the installation process.

! Installing Related Software

The Setup program also allows you to install the ModelSim-Altera software, 
the MegaCore IP Library, and the Nios II Embedded Design Suite. All of this 
software is included in the Altera Complete Design Suite DVD-ROM, but may 
not be included in Altera partner development kits. To install these programs, 
make sure the ModelSim-Altera, MegaCore IP Library, or Nios II 
Embedded Design Suite options are turned on in the Setup program. If you 
decide to install these software tools at another time, you must then perform 
a custom installation to install only specific software.
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4. If you will run the Quartus II software with a network (multiuser) 
license, and not a node-locked (single-user) license, click Install 
FLEXlm Server to install the FLEXlm License Manager software on the 
license server only. The Setup program installs the FLEXlm License 
Manager version 9.2 on the user workstation.

The Quartus II software supports network license servers on PCs 
running Windows 2000, Windows XP, or Windows XP Professional 
x64 Edition; on UNIX workstations running Solaris 8 or 9; and on PCs 
running Linux (Red Hat Enterprise Linux 3.0 or 4.0 or SUSE Linux 
Enterprise Server 9). You do not need to install the FLEXlm License 
Manager software on network client PCs or on PCs running the 
Quartus II software using a node-locked (single-user) license. Refer to 
“Upgrading or Setting Up a License Manager Server” on page 27 for 
more information about setting up the license manager server.

5. If you want, you can view education and reference materials by clicking 
one of the following buttons:

– Documentation
– readme.txt file
– Quartus II and Nios II video demos
– Reference designs (Internet access required)

6. Select the software that you want to install under Select the software 
you want to install.

7. Select Recommended install or Custom install under Select install 
type. If you click Custom install, you can specify which software 
components you want to install. If you click Recommended install, all 
of the software that you selected under Select the software you want 
to install will automatically be installed with default settings.

8. You can turn on the TalkBack feature in the Quartus II software to 
enable Altera to receive limited compilation design information, but 
not design logic. The TalkBack feature helps Altera to understand how 
customers use the Quartus II software and devices, so Altera can focus 
on improving features most important to users.

You can turn on the TalkBack feature by turning on Turn on the 
Quartus II software TalkBack feature in the TalkBack Options dialog 
box, which appears at the end of the Altera Complete Design Suite 
installation process if the option is not already turned on. You can also 
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turn the TalkBack feature on or off , once you have installed the Quartus 
II software, in the TalkBack Options dialog box from the Internet 
Connectivity page in the Options dialog box.

Installing the Quartus II Software 
with CD-ROMs

The Quartus II software uses a Setup program for installation. You can 
optionally request CD-ROMs in lieu of the Altera Complete Design Suite 
DVD-ROM.

You should be aware of the following information before you install the 
Quartus II software:

■ You must have system administration (Administrator) privileges.

■ You must have both disk one and disk two of the Quartus II Design 
Software for Windows CD-ROMs to perform the installation. You 
begin the installation with disk one and are prompted to insert disk two 
when necessary.

■ By default, the Setup program installs the Quartus II software in the 
<drive>:\altera\<version number>\quartus system directory, where 
<version number> is the number of the Quartus II software version; for 
example, the default directory for the Quartus II software version 6.1 is 
<drive>:\altera\61\quartus.

■ You can install multiple copies of the same version of the Quartus II 
software on the same PC. Subsequent installations of the Quartus II 
software can have a user-defined name. By default, the Setup program 
uses the format “Quartus II <version number> (Copy <number>)” for 
multiple copies, where Copy <number> is the number of Quartus II 
software installations that are installed on the PC; for example, the 
default name for a second copy of the Quartus II software version 6.1 is 
Quartus II 6.1 (Copy 2). When installing a Quartus II service pack on a 
PC that has multiple copies of the same version of the Quartus II 
software installed, the installation program allows you to choose the 
copy of the Quartus II software that receives the service pack.
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■ If you want to preserve project compilation databases from an earlier 
version of the Quartus II software before installing a newer version, 
Altera recommends that you open the design in the earlier version of 
the software and export a version-compatible database for the design 
by clicking Export Database on the Project menu. After you have 
installed a newer version of the Quartus II software, you can import the 
database in the new version by clicking Import Database on the Project 
menu. For more information about importing and exporting version-
compatible databases, see “Exporting and Importing Version-
Compatible Database Files” in Quartus II Help. Version-compatible 
database files are available in Quartus II software version 4.1 and later.

Follow these steps to run the Setup program on your PC:

1. Insert disk one of the Quartus II Design Software for Windows 
CD-ROM into your CD-ROM drive. The Quartus II Install CD window 
appears automatically, offering several options. If the CD-ROM is in the 
drive, and the Setup program is not already running, start the Setup 
program manually by performing the following steps:

a. On the Windows Start menu, click Run.

b. In the Run dialog box, type <CD-ROM drive>:\install.

c. Click OK.

2. Click Install Quartus II and Related Software to install the Quartus II 
software and related software. The Setup program starts automatically 
and guides you through the installation process.

! Installing Related Software

The Setup program also allows you to install the ModelSim-Altera software, 
the MegaCore IP Library, and the Nios II Embedded Design Suite. The CD-ROMs 
for this software are included in the Quartus II subscription packages, but may 
not be included in Altera partner development kits. To install these programs, 
make sure the ModelSim-Altera, MegaCore IP Library, or Nios II 
Embedded Design Suite options are turned on in the Setup program, and 
follow the installation process for those CD-ROMs. If you decide to install 
these software tools at another time, follow the installation instructions 
located in “Installing the ModelSim-Altera Software with a CD-ROM” on 
page 16, “Installing the MegaCore IP Library with a CD-ROM” on page 16, or 
“Installing the Nios II Embedded Design Suite with a CD-ROM” on page 17.
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You can select a full installation or a custom installation. If you select a 
custom installation, you can select which device families you want to 
install, and you can also select whether you want to install EDA 
interfaces or tutorial files.

3. If you want to install the Stand-Alone Programmer and the Stand-
Alone SignalTap II Logic Analyzer, click Install Stand-Alone 
Programmer. The Setup program starts automatically and guides you 
through the installation process.

4. If you will run the Quartus II software with a network (multiuser) 
license, and not a node-locked (single-user) license, click Install 
FLEXlm Server to install the FLEXlm License Manager software on the 
license server only. The Setup program installs the FLEXlm License 
Manager version 9.2 on the user workstation.

The Quartus II software supports network license servers on PCs 
running Windows 2000, Windows XP, or Windows XP Professional 
x64 Edition; on UNIX workstations running Solaris 8 or 9; and on PCs 
running Linux (Red Hat Enterprise Linux 3.0 or 4.0 or SUSE Linux 
Enterprise Server 9). You do not need to install the FLEXlm License 
Manager software on network client PCs or on PCs running the 
Quartus II software using a node-locked (single-user) license. Refer to 
“Upgrading or Setting Up a License Manager Server” on page 27 for 
more information about setting up the license manager server.

5. If you want to view the Quartus II software readme.txt file, click View 
Quartus II readme.txt file.

6. You can turn on the TalkBack feature in the Quartus II software to 
enable Altera to receive limited compilation design information, but 
not design logic. The TalkBack feature helps Altera to understand how 
customers use the Quartus II software and devices, so Altera can focus 
on improving features most important to users.

You can turn on the TalkBack feature by turning on Turn on the 
Quartus II software TalkBack feature in the TalkBack Options dialog 
box, which appears at the end of the Quartus II software installation 
process if the option is not already turned on. You can also turn the 
TalkBack feature on or off, once you have installed the Quartus II 
software, in the TalkBack Options dialog box from the Internet 
Connectivity page in the Options dialog box.
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Installing the ModelSim-Altera 
Software with a CD-ROM

You can install the ModelSim-Altera software on PCs running Windows 
2000, Windows XP, or Windows XP Professional x64 Edition. The 
readme.txt file in the quartus directory on the CD-ROM provides 
information on the ModelSim-Altera software operating requirements and 
licensing. You should read the readme.txt file before installing the 
ModelSim-Altera software. You must have system administration 
(Administrator) privileges to install the ModelSim-Altera software.

To install the ModelSim-Altera software on a PC, follow these steps:

1. Insert the ModelSim Altera VHDL & Verilog HDL Simulation Tool, 
Version 6.1g CD-ROM into your CD-ROM drive.

2. On the Windows Start menu, click Run.

3. In the Run dialog box, type <CD-ROM drive>:\modelsim\pc\
modelsim-altera.exe.

4. Click OK. The Setup program starts automatically and guides you 
through the installation process.

Installing the MegaCore IP Library 
with a CD-ROM

You can install the MegaCore IP Library on PCs running Windows 2000, 
Windows XP, or Windows XP Professional x64 Edition. The readme.txt file 
in the top-level directory on the CD-ROM provides information on the 
MegaCore IP Library. You should read the readme.txt file before installing 
the MegaCore IP Library. You must have system administration 
(Administrator) privileges to install the MegaCore IP Library.

To install the MegaCore IP Library on a PC, follow these steps:

1. Insert the MegaCore IP Library Version 6.1 CD-ROM into your CD-
ROM drive.
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2. On the Windows Start menu, click Run.

3. In the Run dialog box, type <CD-ROM drive>:\windows\
setup.exe.

4. Click OK. The Setup program starts automatically and guides you 
through the installation process.

Installing the Nios II Embedded 
Design Suite with a CD-ROM

You can install the Nios II Embedded Design Suite on PCs running 
Windows 2000, Windows XP, or Windows XP Professional x64 Edition. The 
readme.txt file in the top-level directory on the CD-ROM provides 
information on the Nios II Embedded Design Suite. You should read the 
readme.txt file before installing the Nios II Embedded Design Suite. You 
must have system administration (Administrator) privileges to install the 
Nios II Embedded Design Suite.

To install the Nios II Embedded Design Suite on a PC, follow these steps:

1. Insert the Nios II Embedded Design Suite for Windows CD-ROM into 
your CD-ROM drive.

2. On the Windows Start menu, click Run.

3. In the Run dialog box, type <CD-ROM drive>:\launcher.exe.

4. Click OK. The Setup program starts automatically and guides you 
through the installation process.

f For Information About Refer To

Using MegaCore functions with the 
Quartus II design software

MegaCore user guides that are installed 
with the MegaCore IP Library and on the 
Altera website.
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Installing the TCP/IP Protocol
If you do not already have the TCP/IP protocol installed on the PCs in your 
network, you must add it to your networking configuration.

Setting up the Quartus II Software 
with a JTAG Server on a Network 
Drive

If you install the Quartus II software on a network drive and have a JTAG 
server, you must set the Quartus II software to allow the JTAG server to run 
JTAG services.

To set the Quartus II software to enable the JTAG server to run JTAG 
services:

1. On Windows Start menu, click Run.

2. In the Run dialog box, type <drive>:\<Quartus II software system 
directory path>\:jtagserver --install <username> <password>. 
Where the <username> <password> are the username and password of 
the JTAG server.

or

v Install the Quartus II software on a local drive. 

f For Information About Refer To

Installing the TCP/IP protocol on PCs 
running Windows 2000, Windows XP, 
or Windows XP Professional x64 
Edition

Windows 2000, Windows XP, or 
Windows XP Professional x64 Edition 
documentation or to the Microsoft website 
at www.microsoft.com.
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Introduction
This chapter describes how to license the Quartus II software and related 
software.

To set up your license for the Quartus II software, you must perform the 
following steps, which are described in more detail in this chapter:

1. If necessary, obtain a license file. The Quartus II software requires a 
valid, unexpired license.dat license file for each server that supports a 
network (multiuser) license or for each node-locked (single-user) 
license. This same license file can also enable the additional Altera 
simulation tools included with Altera software subscriptions, as well as 
the MAX+PLUS II software.

2. If you are using a network license (FLOATALL or ADD-FLOATALL), 
modify the license file.

3. If you are using a network license, set up and configure the FLEXlm 
license manager server.

or

If you are using a node-locked (FIXEDPC) license, install a Sentinel 
Software Guard.

4. Start the Quartus II software.

! Using Automatic Web License Retrieval

If you are using a node-locked (FIXEDPC) license and are a new user or are upgrading 
to a new version of the Quartus II software, you can perform an automatic web 
license retrieval at startup, which allows you to upgrade your license file 
automatically. For more information on this option, go to “Starting the Quartus II 
Software” on page 37.

! Network License for the Quartus II Software Version 6.0 or Earlier

For Quartus II software version 6.0 or earlier, the network license is FLOATPC, 
FLOATNET, or FLOATLNX.
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5. Specify the location of the license file.

6. Register for an Altera.com account. (Optional)

Obtaining a License File
When you start the Quartus II software, if the software cannot detect a valid 
license file, you are asked whether you want to run in evaluation mode for 
30 days, perform an automatic license retrieval from the Altera website, or 
specify the correct location of a valid license file.

You can also obtain a license file, license.dat, from the Licensing section of 
the Altera website at www.altera.com/licensing if you have the following 
information:

■ Your Altera ID, which is a six-digit number that is provided when you 
purchase the Quartus II development system. This number is listed on 
the packing list that is shipped with the Quartus II software.

■ Your serial number, which can be one of the following numbers:

– If you have a network (multiuser) license version of the Quartus II 
software, the serial number is printed on the side of the Quartus II 
shipping box, and on the Registration & License File Request Form, 
which is also included with the Quartus II software package. This 
number begins with the letter G, and is followed by five digits 
(Gxxxxx).

– If you have a node-locked (single-user) version of the Quartus II 
software, the serial number is the number on your Software 
Guard. This number begins with the letter T.

■ Your Network Interface Card (NIC) number. To find your Windows 
2000, Windows XP, or Windows XP Professional x64 Edition server 
NIC number by using FLEXlm utilities, type the following command at 
a command prompt:

<drive>:<Quartus II system directory>\bin\lmutil lmhostid r
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To obtain a license file, follow these steps:

1. Start the Quartus II software as described in the “Starting the Quartus II 
Software” on page 37.

2. Select Perform automatic web license retrieval to request a valid 
license file automatically from the Altera website. If you are using a 
node-locked (FIXEDPC) license and the Quartus II software is able to 
retrieve a license file successfully from the website, you can skip the 
remaining steps of this procedure. If you are using a network 
(multiuser) license, or if the Quartus II software is not able to retrieve a 
license file, you are guided through the licensing procedure.

or

To request a license file at a later time, go to the Licensing section of the 
Altera website at www.altera.com/licensing. The Altera Software 
Licensing page appears.

3. If you are using a node-locked (single-user) license, select the FIXEDPC 
license option. 

or

If you are using a network (multiuser) license, select the FLOATALL 
or ADD-FLOATALL license option.

4. Specify the requested information.

5. You will receive an e-mail from Altera with a license.dat file attached, 
as well as the license file text. Altera recommends using the attached 
license file if you are using a node-locked (single-user) license. If you 

! Saving Previous license.dat Files

Altera recommends that you save any previous license.dat file in a temporary 
directory, in case you need to refer to it later.

! Network License for the Quartus II Software Version 6.0 or Earlier

For Quartus II software version 6.0 or earlier, the network license is FLOATPC, 
FLOATNET, or FLOATLNX.
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are using a network (multiuser) license, you may either use the 
attached license file, or copy the lines from the attached license file to 
an existing license file. If you are using the license.dat file with both the 
Quartus II software and the MAX+PLUS II software, Altera 
recommends that you save the license.dat file in a top-level directory 
named <drive>:\flexlm.

Figure 1 shows the Quartus II FEATURE line of a sample license file for a 
node-locked (single-user) license that uses a Software Guard.

Figure 1. Sample Node-Locked (Single-User) License File

Figure 2 on page 24 shows a sample single-server network license file for a 
PC.

f For Information About Refer To

Additional methods of finding your NIC 
number

Altera website at www.altera.com.

Using the FLEXlm utilities FLEXlm End Users Guide, which is available 
from the Support Services section of the 
Macrovision website at 
www.macrovision.com.

FEATURE quartus alterad 2006.12 permanent uncounted 2BC9FE52E0F3 \
HOSTID=GUARD_ID=T000002287 SIGN="1C66 DAC6 1DAB C886 727B 65DF FAC2 B479 3E3C \ 
656D 3561 E5D0 BBA3 C45C 4DDC 0F2F 68F5 4DF1 6F63 7785 2F5D 1480 1B0A 70DE \ 
2220 1952 DDCD 9F4D 6D61 A177"

Feature 
name

Daemon 
name

Release 
date

Expiration 
date

Number of 
licenses 
requested

Authorization 
code
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Figure 2. Sample Single-Server Network License File

If you are using the Quartus II software with a node-locked (single-user) 
license, skip to “Installing a Sentinel Software Guard” on page 33.

The FLEXlm licensing scheme allows you to set up three redundant license 
servers to serve a network (multiuser) license. You can obtain a license file 
for redundant servers by performing the steps described earlier in this 
section for obtaining a license file. Figure 3 shows a sample redundant server 
license file.

Figure 3. Sample Redundant Server License File

SERVER alice 00c04f6bead6 1800
VENDOR alterad "<drive>:\altera\quartus42\bin\alterad.exe"
USE_SERVER
FEATURE quartus alterad 2006.12 permanent 5 7A496D25A602 SIGN="1C66 DAC6 1DAB C886 \ 

727B 65DF FAC2 B479 3E3C 656D 3561 E5D0 BBA3 C45C 4DDC 0F2F 68F5 4DF1 6F63 \ 
7785 2F5D 1480 1B0A 70DE 2220 1952 DDCD 9F4D 6D61 A177"

Server 
host ID 
name

Optional port 
number

Authorization 
code

Number of 
licenses 
requested

Server 
name

Feature 
name

Daemon 
name

Release 
date

Expiration 
date

SERVER alice 00c04f6bead6 1800
SERVER king 00c4fbbd170 1800
SERVER queen 00c4fbbd320 1800
VENDOR alterad "<drive>:\altera\quartus42\bin\alterad.exe"
USE_SERVER
FEATURE quartus alterad 2006.12 permanent 5 7A496D25A602 SIGN="1C66 DAC6 1DAB C886 \ 

727B 65DF FAC2 B479 3E3C 656D 3561 E5D0 BBA3 C45C 4DDC 0F2F 68F5 4DF1 6F63 \ 
7785 2F5D 1480 1B0A 70DE 2220 1952 DDCD 9F4D 6D61 A177"

Server ID 
number

Optional port 
number

Authorization 
code

Number of 
licenses 
requested

Server 
name

Feature 
name

Daemon 
name

Release 
date

Expiration 
date
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Modifying the License File
If you have a network (multiuser) license, the license.dat file must be 
modified before it can be used by the license server. See Application Note 340 
(Altera Software Licensing), which is available from the Literature section of 
the Altera website at www.altera.com/literature, for a detailed description 
of the license file.

The first few lines of the license file are shown in the following example 
(your license file may not contain all the VENDOR entries, depending on 
which software you have enabled):

SERVER <host name> <8- or 12-character host or NIC ID> <port number>
VENDOR alterad "<path to daemon executable>"
VENDOR mgcld "<path to daemon executable>"

To modify the license file, follow these steps:

1. In the license.dat file, type the variables that are described in Table 1. 
The host or NIC ID will already be entered in the license file.

f For Information About Refer To

Setting up and administering license 
servers, including setting up three 
redundant license servers

FLEXlm End Users Guide, which is available 
from the Support Services section of the 
Macrovision website at 
www.macrovision.com.

! If You Have a Node-Locked (Single-User) License

If you have a node-locked (single-user) license, you can skip this section and go to 
“Installing a Sentinel Software Guard” on page 33.
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2. Make sure the license file meets these guidelines:

– The license file name must have a .dat extension. If your text editor 
adds .txt or another extension to the file name, such as 
license.dat.txt, you must rename the file to have only a .dat 
extension.

– The license file must have a carriage return at the end of the last 
FEATURE line.

– Any FEATURE line that wraps to a second or third line outside of 
the VENDOR_STRING specification must contain a backslash (\) at 
the end of each line to indicate that it continues. Inside the double 
quotes of the VENDOR_STRING, backslashes should not be used.

Table 1. Variables to Modify in the License File (license.dat) 

Variable Name Description Directory

<host name> The host name of the server; for example, my_server.

<port number> 
(1)

The port number for the license manager service on the server; for 
example, 1800. The port number is optional and should be different 
from the port number for any other service on the machine.

alterad "<path 
to daemon 
executable>" (2)

Path to the Altera vendor 
daemon executable alterad.

\<Quartus II system 
directory>\bin\alterad.exe

mgcld "<path to 
daemon 
executable>" 
(2)(3)(4)

Path to the Mentor Graphics 
vendor daemon executable 
mgcld.

\<ModelSim-Altera system 
directory>\win32aolem\
mgcld.exe

Notes:
(1) If you do not specify a port number in the license file, the FLEXlm License Manager will 

automatically choose a free port between 27000 and 27009. However, to prevent port number 
conflicts, you can specify a port number. If three redundant servers are being used, you must 
specify a port number. For PC-based license servers, Altera recommends that you specify a port 
number of 1800. However, you can use any unused port number between 0 and 64000.

(2) In some network environments, the license server does not have an installation of the software 
tool(s) that provides the necessary vendor daemon (alterad or mgcld). In this case, copy the 
required daemon from another machine that does have an installation of the software. Find the 
file in the directory location specified. Save the file in a similarly named directory or any other 
location on the license server. Specify the daemon location on the license server in the license 
file. 

(3) If the path to the server has spaces in it, enclose the full path in quotation marks.
(4) If you are not using a license file for the ModelSim-Altera software, you may delete this line.
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Upgrading or Setting Up a License 
Manager Server

This section provides instructions for upgrading or setting up the FLEXlm 
License Manager server software on a PC running Windows 2000, 
Windows XP, or Windows XP Professional x64 Edition. A system 
administrator should perform these steps to configure license servers after 
the Quartus II software is installed.

Upgrading the FLEXlm License Server 
Software

To support network licensing, the Quartus II software requires the FLEXlm 
License Manager software version 8.0 or later. The Quartus II Setup program 
installs version 9.2 of the FLEXlm License Manager server software on 
Windows 32-bit systems or version 11.1.1 of the FLEXlm License Manager 
server software on Windows XP Professional x64 Edition systems on your 
user workstation, but you should also verify that the version of the FLEXlm 
License Manager software or the license server is 8.0 or later. Go to 
“Installing the Altera Complete Design Suite DVD-ROM” on page 10 for 
more information on installing the FLEXlm License Manager server 
software. If the FLEXlm License Manager software is version 8.0 or later, 
skip to “Rereading an Existing License File” on page 29.

f For Information About Refer To

Modifying the license file for the 
Quartus II and MAX+PLUS II software 
and for other EDA tools

Application Note 340 (Altera Software 
Licensing) on the Altera website.

! If You Have a Node-Locked (Single-User) License

If you have a node-locked (single-user) license, you can skip this section and go to 
“Installing a Sentinel Software Guard” on page 33.
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To determine which version of the FLEXlm License Manager server software 
you are using: 

v On the computer running the FLEXlm License Manager server 
software, type the following commands at a command prompt:

<drive>:\<FLEXlm system directory path>\lmgrd -v r
<drive>:\<FLEXlm system directory path>\alterad -v r

If the lmgrd or alterad daemons are not from the FLEXlm software version 
8.0 or later, you must upgrade both daemons with the versions provided in 
the installation of the Quartus II software.

To upgrade an older version of the FLEXlm License Manager server 
software, follow these steps:

1. Make a backup copy of the lmgrd and alterad daemons you are 
currently using.

2. To overwrite or replace the daemons you are currently using, copy the 
new versions of the files to the computer running the license server. 
You may have to shut down the license server software to complete this 
step.

If you used the Quartus II Setup program to install the FLEXlm License 
Manager server software, the current version of the lmgrd and alterad 
daemons are located in the following directories:

<drive>:\<Quartus II system directory>\bin\alterad
<drive>:\<Quartus II system directory>\bin\lmgrd

3. Copy the FLEXlm software lmutil utility from the Quartus II system 
directory to the license server.

4. Restart the FLEXlm license server by typing the following commands 
at a command prompt:

<drive>:\<FLEXlm system directory path>\lmutil -c lmdown 
<license file path> r

<drive>:\<FLEXlm system directory path>\lmgrd -c <license file path> 
[-l <optional log path>] r
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Rereading an Existing License File

The Quartus II software uses the FLEXlm software to administer licensing 
for single users or for multiple users in a network installation. If you have an 
existing FLEXlm license server with an existing license file for the 
MAX+PLUS II software or software from another vendor, and the FLEXlm 
license server is version 8.0 or later, you can add, by copying and pasting, 
the Altera FEATURE lines from your Quartus II license.dat file into your 
existing license file. Paste the Quartus II FEATURE line as shown in the 
sample license file in Figure 1 on page 23. Make sure you have also modified 
the license file according to the guidelines in “Modifying the License File” 
on page 25.

If you make these changes to your license file, you must reread the license 
file or restart the license server before you can run the Quartus II software 
for the first time.

Refer to “Upgrading or Setting Up a License Manager Server” on page 27 to 
verify that you are using the latest supported version of the FLEXlm License 
Server software, or if you need to upgrade an older version of the FLEXlm 
License Server software.

To reread your license file on a license server:

v Type the following command at a command prompt:

<drive>:\<Quartus II system directory>\bin\lmutil lmreread r

or

v Restart the license server.

! Configuring a New License Server

If you do not have an existing FLEXlm license server, and you need to configure a 
new license server, skip to “Configuring a New License Server” on page 30.

f For Information About Refer To

Using the FLEXlm utilities to administer 
and troubleshoot the FLEXlm License 
Manager software

FLEXlm End Users Guide, which is available 
from the Support Services section of the 
Macrovision website at 
www.macrovision.com.
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Configuring a New License Server

The Quartus II software uses the FLEXlm software to administer licensing 
for single users or for multiple users in a network installation. If you do not 
have an existing FLEXlm license server, you must configure a license server 
before starting the Quartus II software for the first time.

To launch a new license server:

v Type the following command at a command prompt:

<drive>:\<Quartus II system directory>\bin\lmgrd -c
<license file path>\license.dat r

To configure a new license server as a Windows service:

1. Type the following command at a command prompt:

lmtools r

2. In the LMTOOLS dialog box, click Configuration using Services.

3. Click the Config Services tab.

4. In the Service Name box, type Flexlm License Server.

! Before You Configure a New License Server

You should be aware of the following information before you configure a new 
license server:

■ Configuring a new license server requires that you have system administration 
(Administrator) privileges.

■ If you have an existing FLEXlm license server, refer to “Rereading an Existing 
License File” on page 29.

■ Make sure you have obtained a valid license file according to the guidelines in 
“Obtaining a License File” on page 21, and that you have modified the license 
file according to the guidelines in “Modifying the License File” on page 25.

■ These instructions assume that you have installed the license.dat file in the 
<drive>:\flexlm directory. If you have installed the license file in a different 
directory, substitute the appropriate path name for that directory.
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5. In the Path to the lmgrd.exe file box, type the location of your lmgrd 
file, usually the <drive>:\<Quartus II system directory>\bin 
directory.

6. In the Path to the license file box, type the location of your license.dat 
file, usually the <drive>:\flexlm directory.

7. In the Path to the debug log file box, type the location of your debug 
log file, usually the <drive>:\flexlm\debug.log directory.

8. Click Save Service.

Starting and Stopping the License 
Server

When configuring the license server, you can start and stop the license 
server with the LMTOOLS dialog box. Before you start or stop the license, 
you must configure a new license server as a Windows service. Refer to 
“Configuring a New License Server” on page 30 for more information.

To start or stop the license server with the LMTOOLS dialog box:

1. Type the following command at a command prompt:

<drive>:\<Quartus II system directory>\bin\lmtools r

2. In the LMTOOLS dialog box, click Configuration using Services.

3. Select the name of the license server, usually Flexlm License Server.

4. Click the Start/Stop/Reread tab.

f For Information About Refer To

Configuring a new UNIX workstation 
license server

Quartus II readme.txt file.

Setting up and administering license 
servers, including setting up three 
redundant license servers

FLEXlm End Users Guide, which is available 
from the Support Services section of the 
Macrovision website at 
www.macrovision.com.
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5. To start the server, click Start Server.

or

To stop the server, click Stop Server.

Starting the License Server 
Automatically at Startup

When configuring the license server, you can setup the license server to start 
automatically at startup with the LMTOOLS dialog box. Before you setup 
the license server to start automatically at startup, you must configure a new 
license server as a Windows service. Refer to “Configuring a New License 
Server” on page 30 for more information.

To start the license server automatically at startup with the LMTOOLS 
dialog box:

1. Type the following command at a command prompt:

<drive>:\<Quartus II system directory>\bin\lmtools r

2. In the LMTOOLS dialog box, click Configuration using Services.

3. Select the name of the license server, usually Flexlm License Server.

4. Click the Config Services tab.

5. Turn on Use Services.

6. Turn on Start Server at Power Up.

Installing the FLEXlm Software on 
Another License Server

You can install the FLEXlm software on an additional license server.

To install the FLEXlm software on another license server, perform the 
following steps:
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1. Create a directory named <drive>:\<Quartus II system directory>\
bin on the additional license server.

2. Copy the following files from the <drive>:\<Quartus II system 
directory>\bin directory of your original Quartus II software into the 
new directory:

– lmgrd
– lmutil
– alterad
– lmtools

You can also install the FLEXlm software on another license server with the 
Install FLEXlm Server button in the Setup program. Refer to “Installing the 
Altera Complete Design Suite DVD-ROM” on page 10 for more information.

Installing a Sentinel Software Guard
If your Quartus II development system uses a node-locked license and 
includes a Sentinel Software Guard, you must make sure the Sentinel driver 
is installed and then install the Software Guard before you can specify a 
license file.

! Before You Install the Sentinel Software Guard

You should be aware of the following information before you install a Sentinel 
Software Guard:

■ If you have a network (multiuser) license, you can skip this section and go to 
“Starting the Quartus II Software” on page 37.

■ Current Quartus II single-user license packages provide USB Software Guards 
only. Parallel Port Software Guards are no longer provided in Quartus II 
software packages; however, they are still supported for backward 
compatibility. Parallel Port Software Guards are not supported on 64-bit 
systems.
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Installing the Sentinel Driver

The Sentinel driver is required for all Quartus II software systems running 
on Windows XP Professional x64 Edition that use a USB Software Guard, 
and for systems running on Windows 2000 or Windows XP that use a 
Parallel Port Software Guard. The Sentinel driver is installed automatically 
with the Quartus II software.

If the Sentinel driver is not installed, you can install it by following these 
steps:

1. On the Windows Start menu, click Run.

2. If you are installing the USB Software Guard on systems running on 
Windows 2000 or Windows XP, type the following command in the 
Run dialog box:

<drive>:\<Quartus II system directory>\drivers\sentinel\
setup.exe /usb /q3 r

or

If you are installing the USB or Parallel Port Software Guard on systems 
running on Windows XP Professional x64 Edition, type the following 
command in the Run dialog box:

<drive>:\<Quartus II system directory>\drivers\sentinel\
win_xp64\sentinst64.exe /S /v"/qn"r

3. In the Sentinel Driver Setup Program window, on the Functions menu, 
click Install Sentinel Driver. (Windows 2000 or Windows XP only)

4. In the Sentinel Install dialog box, click OK. (Windows 2000 or 
Windows XP only)

5. Restart your computer at the prompt. (Windows 2000 or Windows XP 
only)

! Sentinel Driver Installation Requirement

Installing the Sentinel driver requires that you have system administration 
(Administrator) privileges.
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Setting Up USB Software Guard 
Support for Remote Desktop

If you want to use a USB software guard with the 64-bit version of the 
Quartus II software, and you want to run the Quartus II software with 
Remote Desktop, you must set up the software guard with the following 
procedure:

To set up USB software guard support, follow these steps:

1. If the 64-bit version of the Quartus II software is not already installed 
on a local drive, copy the following executable to the local drive:

<drive>:\<Quartus II system directory>\drivers\sentinel\
win_xp64\sentprotserv64xp64.exe

2. On the Windows Start menu, click Run.

3. Type the following command in the Run dialog box:

<drive>:\<Quartus II system directory>\drivers\sentinel\
win_xp64\sentprotserv64xp64.exe -i

4. Restart your computer.

Installing the USB Software Guard

To install the USB Software Guard on a PC running Windows 2000, 
Windows XP, or Windows XP Professional x64 Edition, follow these steps:

! Remote Desktop USB Software Guard Setup Requirement

Setting up USB software guard support for Remote Desktop with the 64-bit version 
of the Quartus II software requires that you have system administration 
(Administrator) privileges.

! Software Guard Operating System Compatibility

The USB Software Guard is supported only on PCs running Windows 2000, 
Windows XP, or Windows XP Professional x64 Edition.
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1. Locate an unused USB port on the computer.

2. Insert the USB Software Guard into the USB port.

Installing the Parallel Port Software 
Guard

To install the Parallel Port Software Guard on a PC running Windows 2000 
and Windows XP, follow these steps:

1. Locate a parallel printer port (that is, an LPT port) on the computer. If 
you have a printer connected to this port, you must disconnect it 
temporarily.

2. Insert the 25-pin male connector end of the Software Guard into the 
25-pin female connector of the parallel printer port, as shown in 
Figure 4 on page 36.

Figure 4. Attaching the Parallel Port Software Guard to a PC

3. If necessary, reinsert the printer cable connector into the female 
connector of the Parallel Port Software Guard.

Parallel Printer Port
25-Pin Female Connector

Software Guard
25-Pin Female
Connector
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Starting the Quartus II Software
You can start the Quartus II software after installation is complete. In order 
to enable Quartus II features, however, you must specify the license file, 
either within or outside the Quartus II software. For information about how 
to specify your license file, refer to the next section, “Specifying the License 
File.”

You can start either the 32-bit or 64-bit version of the Quartus II software, if 
you have installed the Quartus II software 64-bit components and if your 
system is capable of running the 64-bit version of the Quartus II software. 
Refer to Chapter 1, “Altera Complete Design Suite System Requirements.” 
for system requirements. When you install the Quartus II software, the 64-
bit version of the Quartus II software is also installed automatically during 
a recommended installation.

To start the Quartus II software:

v On the Windows Start menu, point to All Programs, point to Altera, 
point to Quartus II <Quartus II software version>, and then point to 
Quartus II <Quartus II software version> (32-bit) or Quartus II 
<Quartus II software version> (64-bit).

or

v Open a new command prompt window and type the following 
command:

<drive>:\<Quartus II system directory>\bin\quartus r

w Parallel Port Software Guard Warnings

You should be aware of the following information after you insert a Parallel Port 
Software Guard:

■ Do not connect disk drives that use the parallel port or any device, other than 
a printer or the ByteBlaster II or ByteBlasterMV download cable, to either end 
of the Parallel Port Software Guard. Disk drives can destroy a Parallel Port 
Software Guard by drawing more power than the guard is capable of handling.

■ Disconnect the Parallel Port Software Guard before using the parallel port to 
transfer data between computers using a data transfer program. Failure to do 
so can cause damage to the Parallel Port Software Guard.
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When you start the Quartus II software, if the software cannot detect a valid 
license file, you will see a prompt with the following options:

■ Enable 30-day evaluation period with no license file (no 
programming file support)—This option allows you to continue to use 
the Quartus II software for 30 days without programming file support. 
After 30 days, you must have a valid license file in order to use the 
software.

■ Perform automatic web license retrieval—This option displays the 
Licensing section of the Altera website, which allows you to request a 
license file automatically. If you are using a node-locked (FIXEDPC) 
license, the Quartus II software retrieves the license file automatically 
from the website. If you are using a network (multiuser) license, or if 
the Quartus II software is not able to retrieve a license file, you are 
guided through the licensing procedure. See “Obtaining a License File” 
on page 21 for more information.

■ Specify valid license file—This option displays the License Setup 
page of the Options dialog box, which allows you to specify the 
location of your license file. See the next section, “Specifying the 
License File,” for more information.

Specifying the License File
Once you have obtained a license file and set up a network license server (for 
multiuser licenses) or installed a USB or Parallel Port Software Guard (for 
single-user licenses), you must specify the location of the license file for each 
user (or “client”). You can specify the license file with one of the following 
methods, which are described in more detail in this section:

■ Specify the license file with the Quartus II software.

■ Specify the license file with the Windows 2000, Windows XP, or 
Windows XP Professional x64 Edition System control panel.

! Specifying the License File for the ModelSim-Altera Software

If you are using the ModelSim-Altera simulation software, which is included with 
Altera software subscriptions, and/or you are using the MAX+PLUS II software, you 
must specify the license file with the System control panel.
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Specifying the License File within the 
Quartus II Software

You can specify the location of your license file from within the Quartus II 
software.

To specify your license file within the Quartus II software, follow these 
steps:

1. Start the Quartus II software as described in the “Starting the Quartus II 
Software” on page 37.

2. Select Specify valid license file to specify the name of the license file. 
The License Setup page of the Options dialog box appears. Figure 5 
shows the License Setup page.

! Specifying the License File from within the Quartus II Software

Specifying the license file from within the Quartus II software does not require 
system administration (Administrator) privileges.

! Starting the Quartus II Software for the First Time

When you start the Quartus II software, if the software cannot detect a valid 
license file, you are asked whether you want to run in evaluation mode for 
30 days, request a valid license file automatically from the Altera website, or 
specify the correct location of a valid license file.
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Figure 5. License Setup Page of the Options Dialog Box

3. In the License file box, specify the full path name of your license.dat 
file. You can browse to locate your license.dat file. Altera recommends 
that you store the license.dat file in a directory named c:\licenses:\
flexlm.

You can also specify the location of the license server by typing a name 
of the format <port>@<host> instead of a license file path name, where 
<host> is the name of is the machine running the license server and 
<port> is the port listed in the license.dat file. Refer to Figure 2 on 
page 24 for a sample network license file to determine your port and 

Current license Option to use LM_LICENSE_FILE variable License file location Web License Update button

Local system information Begin 30-day Grace Period buttonLicensed AMPP/MegaCore functions
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server name, and see Table 1 on page 26 for more information about 
port numbers. If there is no port listed in the license.dat file, you can 
simply specify @<host>.

or

If you want to use the current LM_LICENSE_FILE value specified in 
the System Control Panel, turn on Use LM_LICENSE_FILE variable.

4. If you want the Quartus II software to check the Altera website for 
license file updates, click Web License Update.

5. If you want the Quartus II software to automatically check the Altera 
website for license file updates upon startup, turn on Check the Altera 
web site for license updates at startup in the Internet Connectivity 
page of the Options dialog box.

6. If you want to use the Quartus II software in the “Subscription 
Expiration” grace period and did not already specify that option at 
startup, click Begin 30-day Grace Period. The “Subscription 
Expiration” grace period allows you to use the Quartus II software with 
programming file support for 30 days. When the grace period expires, 
you must obtain an updated license file at the Altera website to 
continue using the Quartus II software with programming file support.

7. Click OK.

The Licensed AMPP/MegaCore functions list of the License Setup page 
lists all of the AMPP and MegaCore functions that are available for the 
license.

! Specifying Multiple License Files

If you have more than one license file or server, separate the port and host 
specifications with semicolons (;), with no spaces between the names and 
numbers.
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Specifying the License File with the 
Windows System Control Panel

You can specify the location of your license file from outside the Quartus II 
software by setting system variables in the Windows 2000, Windows XP, or 
Windows XP Professional x64 Edition System Control Panel.

To specify the license file in the Windows 2000, Windows XP, or 
Windows XP Professional x64 Edition System Control Panel, follow these 
steps:

1. On the Windows Start menu, click Control Panel.

2. Double-click the System icon in the Control Panel window.

3. In the System Properties dialog box, click the Advanced tab.

4. In the Advanced tab, click Environment Variables.

5. Under System Variables, click New. The New System Variable dialog 
box appears.

6. In the Variable Name box, type LM_LICENSE_FILE.

7. In the Variable Value box, type either <drive>:\flexlm\
license.dat or a name of the format <port>@<host>, where <host> is 
the name of the server and <port> is the port listed in the license.dat 
file. Refer to Figure 2 on page 24 for a sample network license file to 
help you determine your port and server name. Refer also to Table 1 on 
page 26 for more information about port numbers. If there is no port 
listed in the license.dat file, you can simply specify @<host>.

! Specifying the License File in System Control Panel

Specifying the license file in the System Control Panel requires that you have 
system administration (Administrator) privileges.

! Specifying Multiple License Files and/or Servers

If you have more than one license file or server, separate the port and host 
specifications with semicolons (;), with no spaces between the names and 
numbers.
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8. Click OK.

If you want the Quartus II software to use the LM_LICENSE_FILE setting 
from your System Control Panel rather than from another license file 
setting, make sure Use LM_LICENSE_FILE variable is turned on in the 
License Setup page in the Options dialog box.

Registering for an Altera.com 
Account

Your copy of the Quartus II software is registered at the time of purchase; 
however, in order to use the mySupport website to view and submit service 
requests, you must also register for an Altera.com account and an Altera 
user name. You can use your Altera user name to access your Altera.com 
account. Although use of the mySupport website requires you to have an 
Altera.com account, this account also makes it easier to use many other 
Altera website features, such as the Download Center, Licensing Center, 
Altera Technical Training online class registration, or Buy On-Line-Altera 
eStore features.

To register for an Altera.com account, follow these steps:

1. Go to the mySupport website:

v To start your web browser and connect to the mySupport website 
while running the Quartus II software, on the Help menu, point 
to Altera on the Web, and then click Quartus II Service Request.

or

v Point your web browser to the mySupport website at 
www.altera.com/mysupport.

2. Follow the instructions on the mySupport website to register for an 
Altera.com account.

If you are not a current Altera subscription user, you can still register for an 
Altera.com account and an Altera user name.
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Licensing Related Software
In addition to licensing the Quartus II software, you must also license any 
other related Altera software you install. This section contains licensing 
procedures for the MegaCore IP Library, Nios II Embedded Design Suite, 
and ModelSim-Altera.

MegaCore IP Library

Once you purchase a license for any of the IP MegaCore functions, you can 
request a license file from the Licensing section of the Altera website at 
www.altera.com/licensing and install it on your computer.

If you have already installed a license for a IP MegaCore function, and then 
you receive a new license file for a new IP MegaCore function, you can either 
append the license file to your existing license.dat file, or you can specify the 
MegaCore function’s license.dat file in the Quartus II software.

Nios II Embedded Design Suite

You can create, compile, and generate time-limited FPGA programming 
files for Nios II hardware systems without obtaining a license file. To 
generate non-time-limited FPGA programming files and flash 
programming files, you must obtain a license for the Nios II processor core 
in addition to the license for the Quartus II software. You do not need a 
license if you will only develop software using the Nios II IDE.

ModelSim-Altera

You can request a ModelSim-Altera license file from the Licensing section of 
the Altera website at www.altera.com/licensing and install it on your 
computer.

The ModelSim-Altera software supports licenses using the Mentor Graphics 
license daemon mgcld. The mgcld daemon is located in the <installation 
directory>\win32aloem\ directory.
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Before starting the ModelSim-Altera, you must set your 
LM_LICENSE_FILE environment variable to the location and filename of 
the ModelSim-Altera license file. For example, the LM_LICENSE_FILE 
environment variable should be set to the location and file name of your 
license file (<installation directory>\licenses\eda\license.dat) or with the 
port@host notation (1900@set).

To set your LM_LICENSE_FILE environment variable to the location and 
file name of the ModelSim-Altera license file, follow these steps:

1. On the Windows Start menu, click Control Panel. The Control Panel 
appears.

2. Double-click System. The System Properties dialog box appears.

3. On the Advanced tab of the System Properties dialog box, click 
Environment Variables.

4. Under System Variables, select LM_LICENSE_FILE.

5. Click Edit. The Edit System Variable dialog box appears.

6. In the Variable value box, type the location of your license file.

7. In the Edit System Variable dialog box, click OK.

8. In the Environment Variables dialog box, click OK.

9. In the System Properties dialog box, click Apply.
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Starting the Quartus II Interactive 
Tutorial

The Quartus II software version 6.1 includes the new Flash-based Quartus II 
Interactive Tutorial. The modules of this tutorial teach you how to use the 
basic features of the Quartus II design software, including design entry, 
compilation, timing analysis, simulation, and programming.

This tutorial includes audio and Flash animation components, and is best 
experienced with a sound card and speakers and at least 1024x768 display 
resolution.

To start the Quartus II Interactive Tutorial after you have successfully 
installed the Quartus II software:

v On the Help menu, click Tutorial.

Once you start the tutorial, you can jump immediately to any tutorial 
module by clicking the Contents button. Once you select a tutorial module, 
you can click ShowMe, GuideMe, or TestMe at any time to jump directly to 
the tutorial mode that best suits your learning style.

Using Quartus II Help
The Quartus II software includes a platform-independent Help system that 
provides comprehensive documentation for the Quartus II software and 
more details about the specific messages generated by the Quartus II 
software. You can view Help in one of the following ways:

■ Press F1 from a highlighted menu command or active dialog box for 
context-sensitive help.

■ Press Shift+F1 or click Context-Sensitive Help  on the toolbar. The 
pointer turns into a Help pointer. You can then point to a menu 
command or active window and click for context-sensitive help.

■ On the Help menu, click Index to view the Index tab. The Index lets you 
search for and display all Help topics related to a keyword or phrase.

■ On the Help menu, click Search to perform a search with the Search 
tab. The Search finds a maximum of 500 topics containing the search 
keyword.
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■ On the Help menu, click Contents to view the Contents tab. The 
Contents outlines the design flow and groups related topics into 
folders, but does not list all the topics in Quartus II Help.

■ On the Help menu, click Messages to view the Messages list. The 
Messages list provides an alphabetical list of all messages and offers 
detailed Help on each message.

■ On the Help menu, click Glossary to view the Glossary list. The 
Glossary list provides definitions to key terminology in the Quartus II 
software.

Getting Help on a Message

To view Help on an individual message, follow these steps:

v In the Messages window, right-click the message on which you want 
to receive Help, and then click Help.

To view the entire alphabetical list of messages:

v On the Help menu, click Messages. 

or

v On the Help menu, click Contents, and then select Messages List from 
the end of the Contents.

f For Information About Refer To

Using Quartus II Help “Help Menu Commands” in Quartus II Help.

“Using Quartus II Help Effectively” in 
Quartus II Help.
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Contacting Altera
You can contact Altera for technical support and product information.

Technical Support

If you need technical support, you can visit the Altera website or the 
mySupport website, or you can call the Altera Applications Department.

Table 1. Quartus II Technical Support Resources

Resource Description

Altera website: www.altera.com

mySupport website: www.altera.com/mysupport

or, on the Help menu, point to Altera on the Web, and then 
click Quartus II Service Request in the Quartus II software. 
This website allows you to submit, view, and update technical 
support service requests.

Telephone: (800) 800-EPLD
(7:00 a.m. to 5:00 p.m. Pacific time, M–F) You need your 6-digit 
Altera ID to access the hotline.

(408) 544-8767
(7:00 a.m. to 5:00 p.m. Pacific time, M–F)

! Registering for an Altera.com Account

In order to use the mySupport website to view and submit service requests, you 
must also register for an Altera.com account. An Altera.com account is required only 
for using the mySupport website; however, having an Altera.com account will also 
make it easier for you to use many other Altera website features, such as the 
Download Center, Licensing Center, Altera Technical Training online class 
registration, or Buy On-Line-Altera eStore features. For more information, refer to 
“Registering for an Altera.com Account” on page 43 in Chapter 2, “Licensing the 
Quartus II Software.”
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Product Information

If you need the latest Altera product information or literature, go to the 
Literature section of the Altera website at www.altera.com/literature. You 
can also purchase printed sets of documentation from the Shop Altera 
website at www.shopaltera.com.

f For Information About Refer To

Altera technical support services and 
product information

The Contact Altera section of the Altera 
website.
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Revision History

The information contained in the The Quartus II Installation & Licensing for 
Windows manual version 6.1 revision 1 supersedes information published in 
previous version.

The version 6.1 manual is updated to contain comprehensive information 
for installing and licensing the Altera Complete Design Suite software.
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Altera Complete Design Suite File 
Organization

During the Altera Complete Design Suite installation, one top-level 
directory is created:

The \altera\<version number> directory contains system software and 
data files and includes the subdirectories shown in Figures 1 and 2.

The main \altera\<version number> directory includes the subdirectories 
shown in Figure 1.

Figure 1. Altera Complete Design Suite System Directory (<drive>:\altera 
\<version number>)

C:\altera\61

ip nios2eds

fir
pci
ddr
sopc_builder_ip
nios2_ip
common
...

bin
components
documents
examples
...

docs
drivers
examples
verilog
vhdl
.. .

fir_filter
.. .

quartus qdesignsmodelsim_ae
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The \altera\<version number>\quartus directory includes the 
subdirectories shown in Figure 2.

Figure 2. Quartus II Software System Directory (<drive>:\altera\<version 
number>\quartus)

C:\altera\61\quartus

tcl

misc

librarian

ip

help

flow

devinfo

advisors

common drivers

cadence

fv_lib

hspice

ibis

innoveda

mentor

sim_lib

synopsys

synthesis

edabin

vhdl93

vhdl87

sim

primitives

other

megafunctions

systemc

synthinclude

include

bin

win2000

usb_blaster

sentinel

i386

libraries lmf

documents

model
...

components

europa
gtf
perl_lib
...

bin

sopc_builerbin64 cusp

...
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A

Altera Complete Design Suite 6
installing 10

altera directory 53
Altera on the Web command 43
Altera website 49
Altera, contacting 49
Altera.com account 43, 49

C

CD-ROM
installing FLEXlm software for PCs 12, 

15
installing MegaCore IP Library 16
installing ModelSim-Altera 

software 16
installing Nios II Embedded Processor 

software 17
installing Quartus II software 2

contacting Altera 49

D

directory structure 53
documentation conventions vii
driver, installing Sentinel 34, 35
DVD-ROM

installing Altera Complete Design 
Suite 10

E

EDA interfaces, installation 12, 15
Ethernet connection 3

F

FLEXlm software
FLEXlm manual website 23, 25, 29

installing an additional license 
server 32

installing for PCs 12, 15
rereading 29
upgrading 27

H

Help
finding keywords in 49
on messages 48
using 47

I

installation
Altera Complete Design Suite 10
EDA interfaces 12, 15
FLEXlm software 12, 15
MegaCore IP Library 11, 14
ModelSim-Altera software 11, 14
Parallel Port Software Guard 36
Quartus II software 2
Sentinel driver 34, 35
USB Software Guard 35

L

license file
configuring 30
license.dat file 21
modifying 25
obtaining 21
setting up 27
specifying 38
upgrading 27

license.dat file 21
licensing related software 44
lmhostid utility 21
lmutil utility 21, 28, 29

Index
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M

MAX+PLUS II software, using with 
Quartus II license file 22, 38

messages, getting Help on 48
ModelSim-Altera software

installing 11, 14
specifying license file 38

modifying Altera software 4
mySupport website 43, 49

O

Options command 39

P

parallel port 3
Parallel Port Software Guard 36
Pentium II 2
port number, specifying 41
product information 50

Q

Quartus II Help
using 47

Quartus II software, starting 37

R

readme.txt file 4
registering for an Altera.com account 43
Registration & License File Request 

Form 21

S

Sentinel driver, installing 34, 35
serial number 21
serial port 3
Setup program, running 13
ShopAltera.com website 50
Software Guard

installing Parallel Port Software 

Guard 36
installing Sentinel driver 34, 35
installing USB Software Guard 35
serial number 21

system requirements 2

T

TalkBack, turning on 12, 15
TCP/IP protocol 18
technical support 49
tutorial, starting the Quartus II Interactive 

Tutorial 47

U

uninstalling Altera software 4
USB port 3
USB Software Guard 35

W

Windows
installing Quartus II software 13
installing the Altera Complete Design 

Suite software 10
Windows 2000 & Windows XP

specifying license file 38
TCP/IP Protocol 18
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